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About the WhatsUp Gold MSP Edition 
The WhatsUp Gold MSP Edition extends the capabilities of a single WhatsUp product to let 
you monitor multiple remote networks (sites) from a central location. This solution includes a 
WhatsUp Gold Central installation and a WhatsUp Gold Remote installation. 

The WhatsUp Gold Central Site installation coordinates data feeds from multiple WhatsUp 
Remote Site installations. The network data can then be viewed in reports that you select and 
customize on the Central Site. The Central and Remote installations, together, provide high 
visibility to the networks from one central location.  

   
 

About the MSP Edition reporting capabilities 
The WhatsUp Gold MSP Edition lets you set up and view reports associated with each 
monitored network. You set up centralized reports on the Central Site to gather key data 
from the Remote Sites. With the monitoring and reporting capabilities you can be confident 
that you will stay informed about the overall network health. In fact, if you loose the 
connection between the Central and Remote Sites, the information from the last network 
scan is still available on the Central Site. Each Remote Site continues to run an independent, 
full-featured version of WhatsUp, so it continues to gather network data, regardless of the 
connection status between the Remote and Central Sites.   
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All data communicated between the Central and Remote Sites is transferred over Secure 
Socket Layer (SSL) protocol to ensure that data is secure and confidential. The SSL 
communications between sites occur seamlessly, with no extra user setup required. 
 

System requirements 

Minimum software requirements 
 Windows XP Professional SP2 (or later), Windows 2003 Server SP1 (or later), Windows 

Vista Ultimate, or Windows Vista Business (Windows Vista SP1 recommended). 

 Microsoft Internet Explorer 6.0 SP1 (or later) or Firefox 2.0 (or later) 

 Microsoft .NET Framework v 2.0 or 2.0 SP1 

 Microsoft Windows Scripting Host v5.6 or later  

Windows Scripting Host is installed with the Windows operating system. To verify your 
version, run cscript.exe at a command prompt. 

If you need to update Windows Scripting Host, refer to the Microsoft Windows Scripting 
Host site (http://www.ipswitch.com/wsh56). 

 Internet connectivity for activation, connecting Central and Remote Sites, and running 
the web interface. 

Minimum hardware requirements 
 Intel Pentium-compatible 2 GHz or faster 

 1 GB memory (RAM) (2 GB RAM recommended) 

 256 MB of drive space (up to 4 GB additional for SQL Server 2005 Express Edition database 
and 7200 RPM drive recommended) 

 Display resolution support for 1024 x 768 minimum; recommended display resolution is 
1280 x 1024. 

 CD-ROM drive 

 Network Interface Card (NIC) 

 Modem and phone line (for pager, SMS, or beeper actions; modem pooling is not 
supported) 

 GSM modem and active SIM card (for SMS Direct actions) 

 SAPI v5.1 and supporting sound card for Text to Speech Actions; SAPI v5.1 can be 
downloaded from the Microsoft Speech site 
(http://www.microsoft.com/speech/speech2007/default.mspx). 

Microsoft SQL Server 2005 Express Edition (SSEE) requirements 
 SSEE supports up to 4 GB database size and up to 1 GB RAM for the buffer pool. Ensure 

sufficient disk capacity is available for data storage. 

 Note: SSEE supports one CPU. In computers with multiple CPUs, SSEE utilizes only one 
processor. 

 

http://www.ipswitch.com/wsh56
http://www.microsoft.com/speech/speech2007/default.mspx
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Installing Central and Remote Sites 
Installation overview 
The Ipswitch WhatsUp Gold MSP Edition is comprised of the: 

 WhatsUp Gold Central Site component installed on a network computer to collect data 
from and monitor all of the Remote Sites. 

 WhatsUp Gold Remote Site component installed on a network computer at each 
remote location. Each remote site computer monitors the remote site network and 
reports the network status back to the Central Site. 

 Ipswitch Dashboard Screen Manager application automatically installed with the 
WhatsUp Gold Central Site. After the Central and Remote Sites are set up, you can 
configure this application to cycle through a series of selected WhatsUp Gold web 
interface pages and other Web pages that you want to view on a regular basis. The 
Dashboard is ideal to set up across multiple monitors to view multiple networks or 
Remote Sites, increasing visibility to the information that is most important to you. For 
more information, see Step 5: Using the Ipswitch Dashboard Screen Manager application (on 
page 25). 

There are two installation programs for the MSP Edition, one for the WhatsUp Gold Central 
Site and a second for the WhatsUp Gold Remote Site. The installation programs step you 
through the process of installing each part of the application.  

Following are the overview steps required to install the MSP Edition: 

1 Install the Central Site application. For more information, see Step 1: Installing the 
WhatsUp Gold Central Site (on page 5). 

 (Recommended) Select whether to enable the WhatsUp Web server and select the 
Web server port. 

 Create a User Name and Password that the Remote Sites will use when connecting to 
the Central Site. 

 Configure the TCP port that the Remote Sites will use to connect to the Central Site. 
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2 Make sure the firewall ports are specified and open for the inbound connections (from 
the Remote Sites on Port 9394 TCP). For more information see, Step 2: Configuring the 
firewall for Central and Remote Site connections (on page 8). 

 
3 Install the Remote Site application at the remote locations. For more information, see 

Step 3: Installing the WhatsUp Gold Remote Site (on page 8). 

 Select whether to enable the WhatsUp Web server and select the Web server port. 

 Set up the Central Site IP Address and TCP Port that the Remote Site(s) will use to 
connect to the Central Site. 

 Set the User Name and Password that the Remote Site(s) will use to gain access to the 
Central Site. 

 Set up the Display Name for the Remote Site. 

 (Recommended) Enter the HTTP address that the Central Site will use to access this 
Remote Site's Web interface.  

 Run the network discovery to identify devices on the network and set up active and 
passive monitors. 

 
4 Create Workspace Reports on the Central Site installation for each of the Remote Sites. 

For more information see, Step 4: Using Reports for WhatsUp Gold MSP Edition (on page 
11). 
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5 (Optional) Set up the Dashboard application on the Central Site. For more information, 
see Step 5: Using the Ipswitch Dashboard Screen Manager application (on page 25). 

After the above steps are complete, the application is ready to monitor, and be further 
customized and expanded as required. Data will be communicated from the Remote Sites to 
the Central Site. The network data is rolled-up in the workspace reports and full reports that 
you set up. For more information, see Step 4: Using Reports for WhatsUp Gold MSP Edition (on 
page 11). If you enabled access to the Remote Sites, you can drill-down from the Central Site 
reports to detailed historical data on the related Remote Site. 
 

Step 1: Installing the WhatsUp Gold Central Site 

The WhatsUp Gold Central Site serves as the monitoring system for important network 
activity data gathered by the Remote Sites. After the Remote and Central Sites are set up and 
reports are configured on the Central Site, the network status information from each Remote 
Site is communicated to the Central Site.  

Following is the information that is configured during the Central Site installation: 

 SQL Server 2005 Express (SSE) is installed on the Central Site computer. 

 Select whether to enable the WhatsUp Web server and select the Web server port. 

 Configure the TCP port that the Remote Sites will use to connect to the Central Site. 

 Create a User Name and Password that the Remote Sites will use to gain access the 
Central Site. 

 (Optional) Run the network discovery to identify devices on the network and set up 
Active and Passive Monitors. 

To install the WhatsUp Gold Central Site: 

The installation program is similar whether you are installing for the first time or upgrading 
from a previous WhatsUp installation. Steps that apply only to a first-time installation, or only 
to an upgrade, will be identified as such. 

To install or upgrade the MSP Edition: 
1 Log in directly to Microsoft Windows using the Administrator account (or, if you do not 

have an account called Administrator, use an account that has full administrative 
privileges to the computer). Do not use Terminal Services or Remote Desktop to install 
WhatsUp Gold. 

 Note: When installing on Windows Vista, additional steps are necessary for the Task Tray 
application to work properly. For more information, see Task Tray Application fails on 
Windows Vista. 
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2 Start the installation program: 

 If you purchased a WhatsUp Gold CD-ROM, insert the Central Site CD-ROM into the 
appropriate drive. If it does not run automatically, click Start, select Run, then enter 
the CD path followed by AutoRun.exe For example: D:\AutoRun.exe 

 If you downloaded WhatsUp Gold from the WhatsUp Gold Web site, run the 
downloaded Central Site installation application. 

3 Read the Welcome screen.  

The Welcome screen recommends that you disable any running antivirus software, 
estimates how long it takes to install the application, and displays a button that, when 
clicked, displays the release notes. 

Click Next to continue. The License Agreement dialog opens. 

4 Read the license agreement. Select the appropriate option, then click Next. 
5 For first-time installation only: Select the install directories for SQL Server 2005 

Express Edition. The application and data files will be installed in default directories. If 
you want to change the locations, click the browse buttons to find and select a different 
directory. 

 Note: If you want to customize your database setup, you need to first complete the 
installation using Microsoft SQL Server 2005 Express. After installation completes, you can 
manually configure your database as described in Using an alternative database setup. 

 Important: Make sure that you have a large capacity drive selected for data storage. Data 
files can grow up to 4 GB. 

The application and data files will be installed in default directories. If you want to change 
the locations, click the browse buttons to find and select a different directory. 

Click Next.  

 Note: The SQL Server 2005 Express Edition installation may take several minutes. 

6 For new installation only: Select the installation directory for the WhatsUp Gold 
application files. 

The default path is C:\Program Files\Ipswitch\WhatsUp. We recommend that you 
use the default path. Some users prefer to put application files on a partition separate 
from the operating system, which is usually installed on the C: drive, to isolate the 
application from an operating system crash. 

7 For upgrade installation only: Choose whether to backup your current WhatsUp Gold 
database. We strongly suggest that you do this. 

8 For upgrade installation only: Choose how to handle existing Web and Report files.  

If you have previously installed a version of WhatsUp, you may already have Web and 
Report files stored in your installation directory. You can choose to either delete them or 
back them up during the install. 

9 If a sound card is installed and it has SAPI-compatible drivers, the install program asks 
whether you want to install Text to Speech capabilities. If you select No, you can always 
return and install Text to Speech at a later date. 
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10 For new install only: Choose whether to enable the Web server during install and enter 
a port for this installation, then click Next. The default is Port 80. 

 Important: A Web server is required to view WhatsUp reports. If you do not enable a Web 
server during the installation, you need to enable the WhatsUp Web server or IIS Web server 
in order to view WhatsUp reports. 

 Note: This dialog will not be displayed during an upgrade if you have already enabled the 
WhatsUp Web server in a previous version of WhatsUp. 

11 Enter the TCP port that the Remote Sites will use to connect to the Central Site (default 
port is 9394). 

12 Enter a User Name and Password that the Remote Sites will use to access this Central 
Site, then click Next. The Ready to Install the Program dialog opens. 

 Note: Make note of this information. You will need the TCP port and User Name and 
Password information for each Remote Site installation. 

13 Click Install to install the WhatsUp Gold application files. The installation program gives 
you the option to click Back and change options or click Cancel prior to completing the 
installation. 

 Important: When you use an alternative database setup, you will need to run the database 
upgrade scripts when installing a new release of WhatsUp Gold. The installation program will 
warn you if it detects a non-default database. For information on running the upgrade 
scripts, see Upgrading the database schema. 

14 Select whether you want to view the release notes and/or start the program, then click 
Finish. 

After the application starts, you are introduced to the Discover Devices wizard, which lets you 
set options on how to discover your local network. If you want to postpone these steps, click 
Cancel. You can manually start the local Discover Devices wizard in the WhatsUp console 
application at a later time. Start the console application, then click File > Discover Devices. 
 

Changing the Central Site configuration settings 
The WhatsUp Gold Central Site installation program steps you through the configuration 
options for the Central Site. You can also update the configuration settings in the WhatsUp 
Console after installation. 

To update the Central Site configuration: 

 From the WhatsUp console, click Configure > Program Options, then click Central Site 
Configuration. For more information about the configuration settings, see the 
application Help. 
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Step 2: Configuring the firewall for Remote Site 
connections 

Accessing the Central Site 
The WhatsUp Gold MSP Edition is designed to simplify firewall connections. Communications 
are outbound from each Remote Site back to the Central Site, so only one configuration is 
required for all Remote Sites to communicate back to the Central Site. 

After you have set up the WhatsUp Gold Central Site, you need to determine what is required 
for the Remote Sites to connect across WANs, firewalls, routers, and other network security 
measures to communicate back to the Central Site. This information will be required as you 
install and configure each WhatsUp Gold Remote Site.  

If you are not responsible for these network security configurations, contact the appropriate 
network administrator to help you identify the requirements to allow the connections in to 
the Central Site. 

Accessing Remote Sites 
Additionally, it is not required, but you can also configure the Remote Sites to be accessible 
via their Web interfaces. By doing so, users can drill-down from the Central Site to specific 
reports and data on a specific Remote Site. You can control access from the Central Site to the 
Remote Site by providing varying levels of user privileges to data on each Remote Site. For 
more information, see Creating and modifying user accounts (on page 27). 
 

Step 3: Installing the WhatsUp Gold Remote Site 

The WhatsUp Gold Remote Site monitors devices and network activity for each remote 
network site. After the Remote and Central Sites are set up and reports are configured on the 
Central Site, the network status information from each Remote Site is communicated to the 
Central Site. 

Following is the information that is configured during the Remote Site installation: 

 SQL Server 2005 Express (SSE) is installed on the Remote Site computer. 

 Select whether to enable the WhatsUp Web server and select the Web server port. 

 Set up the Central Site IP Address and TCP Port that the Remote Site(s) will use to connect 
to the Central Site. 

 Set the User Name and Password that the Remote Site(s) will use to gain access to the 
Central Site. 

 Set up the Display Name for the Remote Site. 

 (Recommended) Enter the HTTP address that the Central Site's browser will use to access 
this Remote Site's Web interface. 

 Run the network discovery to identify devices on the network and set up Active and 
Passive Monitors. 
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To install the WhatsUp Gold Remote Site: 

The installation program is similar whether you are installing for the first time or upgrading 
from a previous WhatsUp installation. Steps that apply only to a first-time installation, or only 
to an upgrade, will be identified as such. 

To install or upgrade the MSP Edition: 
1 Log in directly to Microsoft Windows using the Administrator account (or, if you do not 

have an account called Administrator, use an account that has full administrative 
privileges to the computer). Do not use Terminal Services or Remote Desktop to install 
WhatsUp Gold. 

 Note: When installing on Windows Vista, additional steps are necessary for the Task Tray 
application to work properly. For more information, see Task Tray Application fails on 
Windows Vista. 

2 Start the installation program: 

 If you purchased a WhatsUp Gold CD-ROM, insert the Remote Site CD-ROM into the 
appropriate drive. If it does not run automatically, click Start, select Run, then enter 
the CD path followed by AutoRun.exe For example: D:\AutoRun.exe 

 If you downloaded WhatsUp Gold from the WhatsUp Gold Web site, run the 
downloaded Remote Site installation application. 

3 Read the Welcome screen.  

The Welcome screen recommends that you disable any running antivirus software, 
estimates how long it takes to install the application, and displays a button that, when 
clicked, displays the release notes. 

Click Next to continue. The License Agreement dialog opens. 

4 Read the license agreement. Select the appropriate option, then click Next. 
5 For first-time installation only: Select the install directories for SQL Server 2005 

Express Edition. The application and data files will be installed in default directories. If 
you want to change the locations, click the browse buttons to find and select a different 
directory. 

 Note: If you want to customize your database setup, you need to first complete the 
installation using Microsoft SQL Server 2005 Express. After installation completes, you can 
manually configure your database as described in Using an alternative database setup. 

 Important: Make sure that you have a large capacity drive selected for data storage. Data 
files can grow up to the 4 GB. 

The application and data files will be installed in default directories. If you want to change 
the locations, click the browse buttons to find and select a different directory. 

Click Next.  

 Note: The SQL Server 2005 Express Edition installation may take several minutes. 
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6 For new installation only: Select the installation directory for the WhatsUp Gold 
application files. 

The default path is C:\Program Files\Ipswitch\WhatsUp. We recommend that you 
use the default path. Some users prefer to put application files on a partition separate 
from the operating system, which is usually installed on the C: drive, to isolate the 
application from an operating system crash. 

7 For upgrade installation only: Choose whether to backup your current WhatsUp Gold 
database. We strongly suggest that you do this. 

8 For upgrade installation only: Choose how to handle existing Web and Report files.  

If you have previously installed a version of WhatsUp, you may already have Web and 
Report files stored in your installation directory. You can choose to either delete them or 
back them up during the install. 

9 If a sound card is installed and it has SAPI-compatible drivers, the install program asks 
whether you want to install Text to Speech capabilities. If you select No, you can always 
return and install Text to Speech at a later date. 

10 For new install only: Choose whether to enable the Web server during install and enter 
a port for this installation, then click Next.  

 Important: A Web server is required to view WhatsUp reports. If you do not enable a Web 
server during the installation, you need to enable the WhatsUp Web server or IIS Web server 
in order to view WhatsUp reports. 

 Note: This dialog will not be displayed during an upgrade if you have already enabled the 
WhatsUp Web server in a previous version of WhatsUp. 

11 Enter the Central Site's Address <Central_Site_ip> (enter only the IP address without 
http://) and the TCP Port that the Central Site will use to listen for a connection from the 
Central Site (default port is 9394). After you have entered this information, you can click 
Test to test the connection to the Central Site.  

12 Enter the User Name and Password that the Remote Site(s) will use to access this 
Central Site, then click Next. The Ready to Install the Program dialog opens. 

 Note: This is the User Name and Password that you set in the Central Site installation 
program. 

13 Enter the Remote Site Display Name. This is the Remote Site name that the Central Site 
will use to identify this Remote Site (for example, Atlanta Office). The name will be 
particularly helpful to identify reports associated with each Remote Site. The default 
name is the computer name. Change it to better describe this Remote Site. 

14 Enter the HTTP Address (recommended, but not required). This is the address that the 
Central Site's browser will use to access this Remote Site. This address allows users to 
click links in the Central Site's Web interface to open browser connections directly to the 
Remote Site's Web interface (if the user has access permissions). Example: 
http://<Remote_Site_ip>:<Web server port> or http://192.168.200.123:8080. Click 
Next.  
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 Note: This IP address should be accessible in order to enable drill-downs into this Remote 
Site installation from the Central Site. If inbound Web connections are not possible, only 
status information will be available at the Central Site. 

15 Click Install to install the WhatsUp Gold application files. The installation program gives 
you the option to click Back and change options or click Cancel prior to completing the 
installation. 

 Important: When you use an alternative database setup, you will need to run the database 
upgrade scripts when installing a new release of WhatsUp Gold. The installation program will 
warn you if it detects a non-default database. For information on running the upgrade 
scripts, see Upgrading the database schema. 

16 Select whether you want to view the release notes and/or start the program, then click 
Finish. 

After the activation screen, you are introduced to the Discover Devices wizard, which lets you 
set options on how to discover your local network. Use this wizard if you plan to monitor the 
Central Site. If you only plan to use the Central Site to monitor Remote Sites, then you can 
click Cancel.  If you want to postpone these steps, click Cancel. You can manually start the 
Discover Devices wizard in the WhatsUp console application at a later time. Start the console 
application, then click File > Discover Devices. 
 

Changing the Remote Site configuration settings 
The WhatsUp Gold Remote Site installation program steps you through the configuration 
options for the Remote Sites. You can also update the configuration settings in the WhatsUp 
Console. 

To update the Remote Site configuration: 
1 From the WhatsUp console, click Configure > Program Options. 
2 Click Remote Site Configuration.  
 

Step 4: Using Reports for WhatsUp Gold  
MSP Edition 

After the Central and Remote Site installations are complete and communicating with each 
other, you can determine the Remote Site reports to setup so you can view network health 
information for each site. 

There are a number of new reports available for the WhatsUp Gold MSP Edition. The two 
types of reports are: 

 Workspace Reports 

 Full Reports 
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Workspace Reports: learning about the Central/Remote  
Workspace Reports 

The WhatsUp Home workspace is the first screen you see after logging in to the WhatsUp 
Gold web interface. This is your personal, customizable Home portal, or workspace. 

 

The WhatsUp Gold Remote/Central workspace reports are similar to the workspace reports 
you may have used in other versions of WhatsUp Gold. The primary difference is the 
Remote/Central workspace reports let you set up workspace reports that watch Remote Site 
network status from your WhatsUp Gold Central Site. For more information, see Learning 
about workspace reports. 

Workspaces are designed to be user-specific, and are configurable to include workspace 
reports specific to users' needs. Workspaces contain multiple views that let you organize 
various workspace reports by the type of information they display. When you begin 
customizing your workspace views, you should consider the types of information you need to 
view most often, the remote sites and devices in which you need to pay closest attention, and 
what level of detail you want to monitor through a particular workspace view. 

There are several Central/Remote workspace reports included in a Remote Sites workspace 
view for the WhatsUp Gold MSP Edition. They are available if you have completed a new 
installation of WhatsUp Gold application. If you are upgrading from a previous version of 
WhatsUp Gold, the Remote Sites reports are not added to the workspace view for existing 
users; however, you can create a new Workspace View and add the default Central/Remote 
workspace reports to it. 
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Following are the default Central/Remote workspace reports included in the Remote Sites 
workspace view: 

Remote/Central Reports Description 

Remote Site List Lists all configured Remote Sites. The report contains: 

Display Name 
Local device 
Last connect time 
Last refresh time 

Device Status (Remote) Provides a status summary of all monitored devices on a selected 
Remote Site. The report contains: 

Display name 
Devices up 
Devices down 
In maintenance 
Last refresh time 

Monitor Status (Remote) Provides a status summary of all monitors configured for the monitored 
devices on a Remote Site. The report contains: 

Display name 
Monitors up 
Monitors down 
Last refresh time 

Remote Site Overview Displays an information overview for a selected Remote Site. The report 
contains: 

Http address 
Last connect time 
Last refresh time 
# of devices 
# of monitors 
# of queries 
Display name 
Device type 
Host name 
Address 

Summary Counts (Remote) Provides a summary for a Remote Site by the total number of: 

Monitored devices 
Up devices 
Down devices 
Devices with down Active Monitors 
Devices in Maintenance 
Active Monitors 
Down Active Monitors 
Up interfaces 
Down interfaces 
Actions fired in the last 4 hours 
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Tail of Action Activity Log 
(Remote) 

Provides the tail (last 10 records) of the Action Log for a device group on 
a Remote Site. The report contains: 

Date 
Source 
Action Name 
Trigger 

Tail of Remote Site Log Provides the tail (last 10 records) of the Remote Site Log. The report 
contains: 

Date 
Type 
Message 
Remote Site 

Active Monitor Status 
(Remote) 

Lists all Active Monitors assigned to devices on the selected Remote Site 

Threshold - Ping by 
Response Time Over 1 ms 
(Remote) 

Displays ping response times by threshold for devices in a specific device 
group on a Remote Site. The report contains: 

Remote Site 
Last snapshot 
Device 
Interface 
Max (ms) 
Avg (ms) 

 
 

Adding Remote/Central workspace reports to your Home Workspace 
You can add new Remote/Central workspace reports, including Top 10 reports, to the home 
workspace to customize workspace reports to best suit your needs. In the Workspace toolbar, 
click Add Content. 
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Use the Add Content To View dialog to add one or multiple Remote/Central workspace 
reports to a workspace. 

 

 Note: The Tail of Remote Site Log is the only workspace report only available from the 
Remote Site. 

To add a workspace report: 
1 Click the + button next to a report category folder, then click a report option box for 

each report you want to add to your workspace. A preview image for each workspace 
report is displayed at the bottom of the dialog. 

 Tip: The Central/Remote Reports shortcut icons indicate that the report data 
originates from a Remote Site. 
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2 Click OK to save changes. The Home Workspace opens with the new workspace report 
added to the page. Also, notice the gray server icons when you first add a Remote Site 
workspace report. This indicates that you need to select a remote site for the workspace 
report.  

 
3 In the new workspace report, click Menu > Configure. 

  
The Configure Remote Report dialog opens. 

4 Select the Remote Site you want to add to the Home Workspace, select other options 
available in the dialog (the options vary depending on the workspace report you 
selected), then click OK. The new workspace report displays in the Home Workspace. 
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5 (Additional options available only for the Remote Site Overview workspace report) 
After you select a Remote Site, the Local device box displays in the dialog. Click the 
Browse (...) button next to the Local device box. The Edit Remote Site dialog opens. 

 
6 The Accept remote site connection option is selected by default. It allows users, with 

rights, the ability to select or deselect (from the Central Site) the option to accept 
connections from Remote Sites.  

The primary reason to clear the check box option is if you need to disable the Central Site 
from accepting connections from this Remote Site. For example, this option could be 
helpful if one of the Remote Sites connected to the Central Site has an unusual amount of 
activity and is using too much bandwidth between sites. You can use this option to 
disable the Central Site from accepting connections from this Remote Site until you 
resolve the problem. 

Use the Local device checkbox to associate a device with the Remote Site. This device is 
often the computer that is running the WhatsUp software on a Remote Site. Associating a 
local device allows you to view the device status from the Remote Site, keeping you 
informed about the connection status with the Remote Site. It also provides easy access 
to the Network Tools for the local device you selected. Click the Browse (...) button, next 
to the Local device box, for a list of devices on the Remote Site. The Select a Device dialog 
opens. 

7 Select a device that you want to associate with the Remote Site workspace report. This 
device will display in the workspace report. Click OK, then click OK to close the Edit 
Remote Site dialog. The Configure Remote Report dialog opens. 

8 Click OK to save changes. The Home Workspace opens displaying the green collecting 
data icons. The icons indicate that the Remote Site has connected and is collecting data 
for the Central Site. 

 

The Remote Site will update shortly or you can click the icons to force a refresh of the 
Remote Site data. 
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Using the Remote/Central workspace reports 
While the Remote Site workspace reports work very much like workspace reports in WhatsUp 
Gold Standard and Premium Editions, there are a few items to note about the reports that 
help you identify them as Remote/Central workspace reports rather than local network 
workspace reports. 

 The Remote Site workspace report header includes a network icon next to the Remote 
Site name to differentiate the Remote Sites from the local network devices (see 1). 

 When you mouse over a Remote Site name, address, group name, status, etc., a shortcut 
icon  displays to indicate that you can click to drill through the information on the 
Remote Site (see 2). When you click the shortcut icon , a new web browser window 
opens for the selected Remote Site. 

 Important: Make sure that you select the option Access Remote Reports for each user that 
you want to provide access to the Remote Site reports. Also, make sure that you select the 
option Configure Remote Sites if you want a user to be able to access and change options 
in the Configure Remote Sites dialog (Go > Configure > Configure Remote Sites). For more 
information, see Configuring user accounts (on page 27). 

 The Last snapshot information indicates the last date and time the Remote Site data was 
sent to the Central Site (see 3). 

 The date and time information turns blue if it has been longer than 5 minutes since 
the remote site last updated. 

 The date and time information turns red if it has been longer than 10 minutes since 
the remote site last updated. 
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Moving and removing Remote/Central workspace reports 
WhatsUp Gold supports drag-and-drop within the web interface. You can move a workspace 
report from one column of a workspace view to another, or position a workspace report 
above or below another workspace report, by selecting it and dragging it to another area of 
the workspace view. These location changes are saved: workspace reports will appear in the 
location to which you moved them after logging out from the web interface or after moving 
between workspace views. 

 

To move a workspace report: 
1 Select the title bar of the report you want to move, then drag it to the desired location. 

A red box highlights the area that the report will be placed when the mouse button is 
released. 

2 Release the mouse button to place the report in the new page location. If you want to 
cancel the move, while the report is selected, press the Esc key on your keyboard. 
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To remove a report: 

In the Web interface, go to the menu for a specific workspace report and click Close.  

 

Keep in mind, when you remove a report, any customizations you have made to it are lost. 
 

Managing Workspace Views 
WhatsUp Gold comes with a few pre-configured workspace "views," including one for Default 
Remote Sites. You can create more of your own workspace views to use along with the pre-
configured views. You can create as many as you feel necessary to organize your system for 
efficient reporting. You can also edit, copy, copy to (another user), and delete these views as 
needed. 

From the Workspace View list, select Manage Workspace Views. 
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In the Manage Workspace Views dialog, you can create new workspace views, and edit, copy, 
or delete an existing workspace view. 

 
 Click New to configure a new workspace. 

 Select an existing workspace view and click Edit to change the current configuration of a 
workspace. 

 Double-click an existing workspace to change its configuration. 

 Select a workspace view, then click Copy to make a copy of that workspace and add it to 
the list. 

 Select a workspace view, then click Copy to to copy an existing workspace from here to 
another user's list of workspaces. 

 Select a workspace monitor view, then click Delete to remove it from the list. 

To create a new workspace view: 
1 From the Manage Workspace Views dialog, select New. The New Workspace View dialog 

appears. 

 
2 Enter the appropriate information in the following fields: 

 View name. Enter a name for the workspace view. 

 View type. Choose a type for the workspace view from the drop-down menu. 
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 Column count. Enter a value for the number of columns you wish to have in the new 
workspace view. Keep in mind, the more columns you include, the smaller the data 
displayed inside a workspace.  

 Enter a value in pixels for each of the workspace columns. 

3 Click OK to save changes. 

To edit a workspace view: 
1 From the Manage Workspace Views dialog, select Edit. The Edit Workspace View dialog 

appears. 
2 Enter the appropriate information in the following fields: 

 Workspace name. The workspace title as it appears in the Workspace Library. 

 Workspace type. The workspace type as it appears in the Workspace Library (Home 
or Device).  

 Note: Workspace view types cannot be changed after a view is created. For example, a 
Home workspace type cannot be changed later to a Device Status workspace type. 

 Column count. The number of columns in the workspace. 

 Column width. The width of each column in the workspace in pixels. 

3 Click OK to save changes. 

To copy an existing workspace view: 
1 From the Manage Workspace Views dialog, select Copy. The Edit Workspace View 

dialog appears. 

 
2 Enter the appropriate information in the following fields: 

 Workspace name. The workspace title as it appears in the Workspace Library. 

 Column count. The number of columns in the workspace. 

 Column width. The width of each column in the workspace in pixels. 

3 Click OK to save changes. 



 Deployment Guide: Installing the WhatsUp MSP Edition to Central and Remote Sites 

  23 

To copy a workspace view to another WhatsUp Gold user: 
1 From the From the Manage Workspace Views dialog, select Copy to. The Edit 

Workspace View dialog appears. 

 
2 Enter the appropriate information into the following fields: 

 Copy to user. Select a user account from the drop-down menu in which to copy the 
workspace view. 

 View name. The name of the workspace view as it will appear in the Workspace 
Library. 

3 Click OK to save. 

To delete a workspace view: 
1 From the From the Manage Workspace Views dialog, click Delete. 
2 Click OK on the dialog that follows. 
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Full Reports: learning about the Central/Remote Full Reports 
The WhatsUp Gold MSP Edition includes two full reports for Remote Sites, located on the 
Reports tab in the System category:  

 Remote Site Log 

 Remote Site Status 

 

Advantages of full Reports 
 Larger than the workspace reports, full reports give you a larger data view, which can be 

useful in pin-pointing the time something happened, or viewing multiple graphed items. 
Many workspace reports link to full reports, so that you can view this larger data view to 
troubleshoot. 

 The date range on full reports can be zoomed in on, or zoomed out on, so that you can 
get a smaller or larger picture of what's going on with a particular aspect of the network.  

 A list in the upper-right corner of a full report screen allows you to navigate to other 
reports in the same category. When you use this list to navigate to another report, the 
date range selected in the report you are navigating away from is transferred to any 
report you view subsequently. 

Much of the data in full reports can be exported to Microsoft Excel or to a formatted text file. 
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Using the Remote Site full reports 
The Remote Site Log provides a record of error messages generated by the Remote Site 
connection attempts.  

 

Click a Remote Site name to open an instance of the Remote Site WhatsUp Gold Web 
interface. For more information about the Remote Site Log, see the application Help. 

The Remote Site Status report provides overview information about the state of the devices 
and active monitors on the Remote Sites.  

 

Click a number in one of the columns to drill-down to more detailed information about up 
and down devices and monitors and devices in maintenance. 

 Note: The Remote Site Status report is only available from the Central Site. 
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Step 5: Using the Ipswitch Dashboard Screen 
Manager application 

After you have the Central and Remote Sites working, have customized your workspace 
reports and started viewing the Remote Site full reports, you can take advantage of the 
Ipswitch Dashboard Screen Manager capabilities. The Dashboard is installed on the Central 
Site by default. However, if you prefer to install the Dashboard on a system other than the 
Central site, you can locate the .exe installation file at ..\Program 
Files\Ipswitch\WhatsUp\Dashboard.exe. 

The Dashboard Screen Manager is a stand-alone application designed to display a series of 
Web pages, or a "playlist," on one or multiple monitors. The Dashboard was created as a 
complement to the Ipswitch network monitoring application, WhatsUp Gold, and as an aid to 
keeping your network visible. The Dashboard application is included in the WhatsUp Gold 
Central and Remote Site installations. 

The Dashboard can run on a display console and cycle through various pages from the 
WhatsUp Gold web interface. Network administrators then have important and pertinent 
network information on display at all times, cycling and changing on its own without the 
need of constant configuration. It also provides the capability to view multiple networks that 
you are monitoring simultaneously. 

Though the Dashboard Screen Manager was created to work along-side WhatsUp Gold, it can 
display virtually any Web page. For example, an Internet business providing service to a small 
town in the desert glances at one screen on the Dashboard and sees that the connectivity to 
the town is down. By displaying the weather for this town on another screen at the same 
time, the network administrator is able to see that the extreme temperatures of the day have 
likely caused problems for the cable transmitters. 

 Note: If you want to display a password protected page for another Web application, you 
must supply a valid username and password for the page. For more information, see the 
Dashboard application Help. 

For more information about installing and using the Dashboard Screen Manager, see Using 
the Ipswitch Dashboard Screen Manager, a document located on the Ipswitch Network 
Monitoring Web site (http://www.whatsupgold.com/). 

To further enhance your network activity visibility, you may also want to set up a multi-
monitor network display, for more information see Setting up a WhatsUp Multi-Monitor 
Network Display, a document located on the Ipswitch Network Monitoring Web site 
(http://www.whatsupgold.com/). 
 

http://www.whatsupgold.com/
http://www.whatsupgold.com/
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Creating and modifying user accounts 

User accounts that are granted the Manage User right can create and edit user accounts.  

 

To create a new or edit a WhatsUp Gold user account: 
1 From the WhatsUp Gold web interface, select GO. The GO menu appears. 
2 On the WhatsUp section of the GO menu, select Configure > Manage Users. The 

Manage Users dialog appears. 
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3 Click New. The Add User dialog appears. 

- or - 

Select a user account and then click Edit. The Edit User dialog appears. 

 
4 Enter the appropriate information. 

 User Name. Enter the name of the user. 

 Authentication Type. Select the method of authenticating the user. 

 Internal. Use the internal user database built in to WhatsUp Gold. 

 LDAP. Use an external LDAP database. 

 Language. Select the language to display for the user. 

 Internal Password. Enter a password for the user. This option is disabled if 
Authentication Type is set to LDAP. 

 Confirm Password. Confirm the user's password. This option is disabled if 
Authentication Type is set to LDAP. 

 Home Group. Select the device group that the user will see when they log into the 
WhatsUp Gold web interface. If they have the correct group access rights, they will be 
able to navigate out of this group. 
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 User Rights. Select the rights that correspond to the actions you want to allow the 
user to complete. 

 Check all rights. Select this option grant the user rights to perform all of the actions 
listed. 

5 Click OK to save changes.  
6 If you have enabled Group Access Rights, you will be prompted if you would like to 

specify Group Access Rights for the new user account. 

 

Select Yes to open the Device Group Properties dialog for the user's home group. 

- or - 

Select No to close the dialog and return to the Manage Users dialog. 
 

Getting more information 

Now that you have your WhatsUp Gold Central and Remote installations up and running, you 
can learn more about using WhatsUp Gold. Following are information resources for WhatsUp 
Gold. This information may be periodically updated and available on the WhatsUp Gold Web 
site (http://www.whatsupgold.com/support/index.asp). 

 Release Notes. The release notes provide an overview of changes, known issues, and bug 
fixes for the current release. The notes also contain instructions for installing, upgrading, 
and configuring WhatsUp Gold. The release notes are available at Start > Programs > 
Ipswitch WhatsUp Gold > Release Notes or on the WhatsUp Gold web site 
(http://www.ipswitch.com/WUG120relnotes). 

 Application Help for the console. The console help contains dialog assistance, general 
configuration information, and how-to's that explain how to use the features. The Table of 
Contents is organized by functional area, and can be accessed from the main menu or by 
clicking Help. 

 Application Help for the web interface. The web interface help contains dialog 
assistance, how-to's that explain how to use features, table of contents, index, and search. 
Click the ? icon to access the Help. 

 Getting Started Guide. This guide provides an overview of WhatsUp Gold, information 
to help you get started using the application, the system requirements, and information 
about installing and upgrading. The Getting Started Guide is available on the WhatsUp 
Gold web site (http://www.ipswitch.com/WUG120GSG). 

 New Features Guide. This guide provides information about the new features in Ipswitch 
WhatsUp Gold v12. This guide is available on the WhatsUp Gold web site 
(http://www.ipswitch.com/wug120fbg). 

http://www.whatsupgold.com/support/index.asp
http://www.ipswitch.com/WUG120relnotes
http://www.ipswitch.com/WUG120GSG
http://www.ipswitch.com/wug120fbg
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 User Guide. This guide describes how to use the application out-of-the-box. It is also 
useful if you want to read about the application before installing. To view or download 
the User Guide, select Help > WhatsUp Gold User Guide or download it from the 
WhatsUp Gold web site (http://www.ipswitch.com/WUG120ug). 

 Translation Guide. This guide describes how to use the translation features to create a 
localized version of the WhatsUp Gold web interface. This guide is available on the 
WhatsUp Gold web site (http://www.ipswitch.com/WUG12Trans). 

 Licensing Information. Licensing and support information is available on the 
myipswitch.com web portal (http://www.myipswitch.com/). The web portal provides 
enhanced web-based capabilities to view and manage Ipswitch product licenses. 

 User Forum. Use the online user group forums to interact with other WhatsUp Gold users 
to share helpful information about the application. The User Forums are available on the 
WhatsUp Gold web site (http://forums.ipswitch.com/). 

 Knowledge Base. Search the Ipswitch Knowledge Base of technical support and 
customer service information. The knowledge base is available on the WhatsUp Gold web 
site (http://support.ipswitch.com/kb/). 

 

http://www.ipswitch.com/WUG120ug
http://www.ipswitch.com/WUG12Trans
http://www.myipswitch.com/
http://forums.ipswitch.com/
http://support.ipswitch.com/kb/
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